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Entering your trial key allows you to save your pro-
cessed images and print them during your evaluation 
period.  Entering your license key allows you do the 
same, except without any time limitations. 

1. Start by opening up an image in Photoshop. 
2. Go to Filters -> Topaz Labs -> DeNoise 5 
3. Once the interface opens, go to  Menu -> Enter key. 
4. You can then copy and paste or type your key in.

Important: To install the product on a second com-
puter, you will need to download Topaz DeNoise 5 and 
then enter your same license key.

Host-Specific Installation
Topaz DeNoise 5 is also compatible with Lightroom, 
Aperture and iPhoto.   To use DeNoise in any of these 
programs you will need to download and install the 
free Topaz Fusion Express compatibility add on.  You 
can get it online at: www.topazlabs.com/downloads

In Windows, Topaz DeNoise 5 is supported by most 
host applications that support Photoshop plug-ins.  
This includes Paint Shop Pro, Photo Impact, Painter, 
and Irfanview, although there are additional host pro-
grams that may also support Topaz DeNoise 5. 

To install DeNoise 5 in either Paint Shop Pro, Photo 
Impact, or Irfranview first download Topaz DeNoise 
to the default location.  Then, to configure it into each 
program following the host-specific instructions on the 
next page. 

Topaz DeNoise is a Photoshop plug-in, which means 
it won’t run by itself and requires a compatible host 
program. 

To Install
1. Close Photoshop or other image editing program if 
you are using it. 

2. Open the Topaz DeNoise dmg or zip file, double-click 
on the Topaz DeNoise installer, and then follow the on-
screen instructions. 

3. Your Topaz plug-ins will automatically be installed in 
your Photoshop plug-ins folder. 

4. After the installation, you will need to enter your 
license or trial key. 

Important for Mac Users: 
After installation, Topaz DeNoise will be installed in the 
following folder: “ Macintosh HD -> Library -> Applica-
tion Support -> Topaz Labs -> DeNoise 5”.

If your Photoshop is installed in a customized location, 
you will need to manually create a shortcut (alias) link 
inside folder “<Photoshop install folder> -> Plug-ins” 
that links to “ Macintosh HD -> Library -> Application 
Support -> Topaz Labs -> DeNoise 5 -> Plug-ins”.

Installation

             Mac Dmg         Windows Zip             Mac Dmg              Mac Dmg 
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1. First launch PaintShop Pro.

2. Go to Menu file -> Preferences -> File Locations. 
Select “Plug-ins” from the “File Types” list and click 
“Add”. 

Installation
3. Choose C:\Program Files \ Topaz Labs \ Topaz De-
Noise 5 plug-ins and click “OK”. 

4. Topaz DeNoise 5 is now available to use. Simply go to 
Effects -> Plug-ins and select “Topaz DeNoise 5”.



5

User Manual
To

pa
z 

 D
eN

oi
se How to install Topaz DeNoise in Photo Impact 

1. First launch  Photo Impact.

2. Go to File -> Preferences -> General or use shortcut 
key F6. 

3. Select Plug-ins from the Categories list. 

Installation
Then click on the           button and browse to find the 
DeNoise 5 plug-in folder located in:  C: \ Program Files \
Topaz Labs \ Topaz DeNoise 5 plug-ins and then click 
“OK”. 

4. Restart Photo Impact. Go to Menu -> Effect to access 
plug-in.
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1. Make sure that you have downloaded and installed 
the 8bf plug-in add-on, available on the Irfanview 
webpage. (http://www.software.com/irfanview-plugin)

2. Open Irfanview and go to Image -> Effects -> Adobe 
8BF filters. 

3. In the screen that pops up, select “Add 8BF filters” 
and navigate to the C: \ Program Files \ Topaz Labs \ 
Topaz DeNoise 5 \ Plug-ins folder and click “OK”. You 
will then see “Topaz DeNoise 5” in the Available / 
Loadable 8BF Filters section. 

4. To use Topaz DeNoise 5 in the future, simply go to 
Image -> Effects> Adobe 8BF filters again and select 
“Topaz DeNoise 5”.

Installation
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Uninstalling
3. Select Programs, then Uninstall a Program.

4. Select Topaz DeNoise and click remove. 

Windows 7*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel -> 
Programs -> Programs and Features. 

3. Select Topaz DeNoise and click uninstall. 

*Please note that if you also have the 64-bit version of 
DeNoise installed, then you will need to first uninstall 
this version before you can uninstall the regular ver-
sion. 

To uninstall Topaz DeNoise follow these instructions:

Mac
1. Quit Photoshop (or other editing program).

2. Navigate to the Topaz Labs support files and frames 
located at: Macintosh HD -> Library -> Application Sup-
port -> Topaz Labs. 

3. Locate the Topaz DeNoise file and move it to the 
trash. You will need to enter your system password to 
OK this change. 

4. Navigate to your Photoshop plug-ins folder located 
at: Applications -> Photoshop -> Plug-ins

5. Locate any leftover Topaz DeNoie files and move it 
to the trash. 

Windows XP*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel.

3. Double-click on Add / Remove programs.

4. Select Topaz DeNoise and click remove. 

Windows Vista*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel.
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Introduction

What Causes Digital Image Noise?
Noise can be a result of a number of things including: 
1. A very sensitive sensor
2. Low light combined with a high ISO. 

What is ISO?
The ISO setting defines how sensitive your camera sen-
sor is to the amount of light present in your scene.  It 
can also vary by camera model.

A higher ISO setting will cause the sensor to be more 
sensitive thus allowing you to take pictures in low-light 
or with faster shutter speeds. 

Noise
What is Noise?
Noise is a random and unwanted problem caused by 
the sensor  (determined by your ISO settings) in digi-
tal cameras.  Most often, noise appears as randomly 
spaced grain or dots distributed throughout your 
image.  Noise can also appear as unevenness in color, 
random pixels of color or as a variation in brightness 
within your image. 

Noise is most noticeable in plain, solid areas of your 
digital image, and is also found in areas of high color 
and in darker areas such as blacks and shadows.  Noise 
is also apparent in underexposed images.  This is be-
cause lower light regions offer comparatively less visual 
information than regions with more light, so noise 
tends to become a problem in these darker settings. 
Brightening dark images can also increase the presence 
of noise in digital images.

Consequences of Noise
The presence of noise creates a visually unpleasant 
image with reduced image detail and clarity.  Noise will 
also create an inconsistency in darker ares of the image 
such as blacks or shadows, leaving these areas looking 
grainy and often with random color specks.  

How to Spot Noise
The true effects of noise may be hard to notice at first, 
but if you zoom in on your digital image - 200% or more 
- you will instantly see the defects. For more information and to see examples visit: 

www.topazlabs.com/denoise
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There are two general types of noise that you will see 
in your digital images:

1. Luminance Noise is the black and white noise or 
“grain” in an image.

2. Chrominance is the pastel-colored, speckled noise 
often seen in mid-tone or shadow areas. 

Uses and Benefits of High ISO Settings
Generally, it’s always best to use the lowest ISO setting 
possible.  However, a higher ISO enables:
1. Faster shutter speeds to freeze motion – ideal for 
indoor sports photography
2. Better performance in low light
3. Reduce image blur when shooting hand held 

Side Effects of High ISO Settings
The side effect to a high ISO setting is noise.  The pres-
ence of noise will reduce your image quality and ob-
scure important subject details.

Noise Removal Tools
There are a variety of noise reduction tools available for 
eliminating image noise.  However all tools come with 
the unwanted side effect of detail loss, which affects 
the overall quality of your image.  Another common 
side effect is image blurring as a result of lost detail. 
These side effects lower the quality and value of your 
image.  Topaz DeNoise uses the most advanced algo-
rithm to preserve detail. 

When Should I use Noise Reduction Software?
The ideal time to remove noise is at the beginning of 
your workflow.  Eliminating noise as a first step is key 
because it will ensure that you are working on a clean 
image.  It is always important to remove any damaging 
defects before applying any color, detail or creative 
adjustments to your images. 

Introduction

Before Topaz DeNoise

After Topaz DeNoise
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About Topaz DeNoise
Topaz DeNoise is an advanced noise detection and 
removal program that reduces noise while retaining an 
restoring image detail offering unprecedented control 
over the clarity of your photos.

Topaz DeNoise specializes in reducing digital image 
noise, while preserving detail and increasing image 
sharpness. 

The primary functions of Topaz DeNoise are: 

1. Remove image noise

2. Retain and restore important image details previ-
ously obscured by noise.  

3. Sharpen edges and color edges.

4. Smooth color unevenness.

5. Eliminate horizontal and vertical banding lines

6.  Correct image black levels to restore true color in 
black and shadow areas. 

7. Rescue underexposed images by removing the ex-
cessive noise that accompanies all brightening expo-
sure adjustments.
 
8. Rescue low-light, high ISO images

9. Help users create high-quality JPEG images

10. Simplify the noise reduction process simple, making 
it powerful, quick, and efficient.

Introduction

To connect with other Topaz users, participate in Topaz 
contests and to see the latest tips, tricks and tutorials sign 

up for the new Topaz Forum online at:
 www.topazlabs.com/forum

Before Topaz DeNoise After Topaz DeNoise
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What is Banding Noise?
Banding noise is a camera-induced artifact that ap-
pears in digital images as parallel patterns of horizon-
tal and vertical lines.  These lines often appear color-
ful. 

There are two forms of banding noise: short band-
ing and long banding.  Short banding noise appears 
in isolated image areas while long banding noise 
extends across the entire image.  Banding is typically 
unpredictable and unavoidable, however it is more 
frequently seen with the use of high ISO speed. 

DeNoise Debanding Technology
Topaz DeNoise now features long banding removal 
capabilities.  The new Debanding tab tackles both 
horizontal and vertical banding, eliminating the long 
colorful lines and restoring image integrity.

Introduction

Before Topaz DeNoise After Topaz DeNoise

Want to see more examples of banding noise and Topaz 
DeNoise’s new debanding technology?

Visit the DeNoise website online at: 
www.topazlabs.com/denoise
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Noise Effects on Image Black Levels
Removing noise from dark and shadow areas of im-
ages affects the image’s black levels - often leaving a 
hazy color cast.  This color cast can make your image 
appear desaturated and less contrasted in the dark 
areas. 

DeNoise 5 Black Level Correction
The new Correct Black Level parameter in DeNoise 5 
allows you to clean up this hazy color cast and restore 
the true richness of blacks and shadows in digital im-
ages. 

This unique color correction tool allows users to 
retain and restore balanced, contrasted color within 
images. 

Introduction

Before Black Level Correction After Black Level Correction

Want to find out more information about noise 
reduction, banding, and black levels?

Visit the Topaz Labs Blog online at: 
www.topazlabs.com/blog

http://www.topazlabs.com/blog
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and how fast it is to get optimal results in your images. 
You can denoise any image in 3 quick steps. 

Step 1: 
Click on the Reset All slider. If desired, select one of the 
default presets. 

Quick and Easy Noise Removal
Topaz DeNoise makes noise remover quicker than its 
ever been, giving you clean and clear images every 
time.  There are two main phases to noise reduction 
with DeNoise.  Phase 1: Noise Reduction and phase 2: 
Detail Recovery.  Setting the appropriate slider values 
in both of these phases is the key to achieving optimal 
image results.

Two optional steps include banding removal and black 
level color correction.  However these adjustments are 
not always not necessary for every image. 

Your First Project
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Then compare the before (Original) and after (Preview) of your image by clicking on the Original and Preview tabs or by 
using your spacebar shortcut key to toggle back and forth.  You can also click on the preview image to toggle the views.

Your First Project
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Your First Project

 3. Once you are satisfied with your changes click OK to process and you will have a clean, noise free image.

And that’s all there is to it!  You can quickly and easily remove noise from any image using DeNoise 5.  

Clear, clear and sharp images are always just a few clicks away. 

Now that you know how, go ahead try it out on your own images!

Before Topaz DeNoise After Topaz DeNoise
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Topaz DeNoise 5.0 Features

1. Speed Increase. Now you can process images twice 
as fast. 

2. Double the image size. Process images twice as 
large. 

3. Debanding Tab. Horizontal and vertical banding 
noise is eliminated with the new dual-directional 
Debanding feature. 

4. Correct Black Levels slider in the Noise Reduction 
Tab. Helps reduce haze (caused by noise) and reveal 
the true richness in the darkest parts of an image.

 

Introduction

Before Topaz DeNoise

After Topaz DeNoise

Before Topaz DeNoiseBefore Topaz DeNoise

Learn more about DeNoise features online at: 
www.topazlabs.com/denoise

http://www.topazlabs.com/denoise
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Work Area

Interface (Main View)

1. Presets 4. Settings and Parameters

Although the Topaz DeNoise interface may look intimidating at first glance, don’t worry: it’s actually quite simple and 
easy to use.  You’ll soon be a pro after experimenting with it for a bit. In order to make sense of the function of each of 
the various controls, we have divided the interface into a few sections:

1 2
3

4

2. Preview Window 3. Preview Navigator
Provides “snapshots” of 
accessible pre-defined
parameter settings.

Controls the editing using sliders 
to adjust the various effects.

Displays the preview of 
the original and adjusted 
image. 

Displays the region of the
preview image you are 
currently focused on. 

2211

44
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Work Area

Interface (Tool Panel View)
Use the small white arrows to expand and collapse the preset panel.  You can click the white arrow            or grab the 
edge of the panel and drag it in or out.

ou can click the white arrow            or grab the 
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Work Area

Interface (No Panel View)
Use the small white arrows to expand and collapse the preset and tool panels.  You can click the white arrows                    
or grab the edge of the panels and drag them in or out.

ou can click the white arrows                    ou can click the white arrows                    ou can click the white arrows                    
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Work Area

Interface (Preset Panel View)
Use the small white arrows to expand and collapse the tool panel.  You can click the white arrow                or grab the 
edge of the panel and drag it in or out.

ou can click the white arrow                or grab the 
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mouse button on the preview image and drag it 
around.  When you let go of the mouse button, the 
new portion of the image will be processed and the 
result will be displayed. 

Preview Section 
The Preview section is the main window that is cen-
tered in the DeNoise interface.  The preview section 
shows you the original image and the processed pre-
view of the image.  Click on the image in the preview 
window (or use the Original and Preview buttons) to 
switch between the Original and Preview tabs and 
compare the filtered and un-filtered images. 

Work Area

You can also use SPACE bar or your numbered 
shortcut keys “1” and “2” to switch back and forth 
between your filtered and unfiltered image in the 

1
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The “Ctrl +” and “Ctrl –” keys zoom in and out of the 
image, just like in Photoshop.  

You can use the arrow keys to adjust the value of the 
slider that is currently selected.  

A complete list of the shortcut keys can be found in 
the Shortcut Keys section later in this manual.

You can zoom in or out of the preview image by click-
ing the “+”, or “-” buttons below the preview image.
You can also resize the window as well by dragging 
the bottom right corner in and out. 

Please note: The minimum that you can zoom out 
is 100%.  Anything below 100% hinders your ability to 
identify and remove image noise. The ideal zoom set-
ting is 200%

Work Area

Photoshop and other host software support many Image 
Modes, such as Grayscale, RGB, LAB, CMYK, etc.  Images 
can also be 8, 16, or 32 bits per channel.  Topaz DeNoise 
supports both 8 bits per channel and 16 bits per channel. 
Topaz DeNoise supports RGB mode only.  To work on 
black-and-white images, first convert them to RGB mode.
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Work Area

Presets
Presets are a great way to speed up and simplify the 
whole process of using Topaz DeNoise.  Presets are 
set previews with previously defined settings that you 
can recall and reapply at any time. 

We’ve included some default presets for you and, al-
though they won’t work for every single photograph, 
they serve as excellent starting points for customized 
tweaking.  

Applying Presets 
Applying a default preset is easy and intuitive. Simply 
clicking on a preset will change all the settings in To-
paz DeNoise to match those in the selected preset. 

To get the exact results you want, you may still want 
to go through the tabs and tweak the parameters.

Adding Presets
Sometimes it’s convenient to be able to define pre-
sets and save your settings for later use.  To do this, 
first adjust the Topaz DeNoise parameters until you’re 
satisfied with the result. Then, click on “Save”. 

 
 

1. Preset Info Box
Provides camera setting 
and profile information 
of the available pre-de-
fined parameter settings 
included in the presets 
list below.

2. Presets List
Lists all of the saved pre-
sets available for use. 

1

3. Preset Options

The preset options al-
low you to save your 
presets, delete presets 
(default presents cannot 
be deleted), import new 
presets and export your 
saved presets to share 
with your friends. 

Remember that you can easily expand or collapse the presets 
panel by clicking on the small white arrow on the edge of the 
panel or by grabbing the panel edge and dragging it in or out.

3

2
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Work Area
Your preset will be automatically saved as a new file 
with a “.tpp” extension in the Topaz DeNoise Presets 
menu and the preview is automatically generated. To 
apply it later, just click it like any other preset.

Deleting Presets
If you’d like to delete a preset the select the preset 
name and then click on Delete.  

Please Note: Default presents cannot be overridden 
or deleted. Once you delete a preset it or overwrite it 
when saving, then it cannot be retrieved.  

Then enter a preset name and select OK to save. It 
is also a good idea to use the other preset fields by 
entering a creator name, camera type, ISO setting, im-
age type and a brief description of the preset. 

You will also need to select a Relative or Absolute 
Preset Type.  A Relative preset setting is generally 
used for broader types of image noise that require 
less precision.  An Absolute preset setting is ideal for 
specific camera and ISO settings.  For more informa-
tion about these Absolute and Relative preset types 
please see page 45.

Note that if the name you’ve entered is the same as a 
preset you’ve already defined then you will be asked if 
overwrite the previous one. 

Saved presets are located in the Topaz DeNoise 5 “Presets” 
folder:
C: \ Program Files \ Topaz Labs \ DeNoise 5 \ Presets unless 
you’ve opted to install Topaz DeNoise into a different directory. 

Mac users have this folder at Macintosh HD / Library / Applica-
tionSupport / TopazLabs / DeNoise 5 / Presets. 
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Have more questions about Topaz DeNoise 5 or any of the 
other Topaz software programs?

 Check out the new Topaz Knowledge Base online at: 
www.topazlabs.com/support/kb

Work Area
Exporting Presets
To export the preset file to a certain location, click 
“Export”. 

Name your preset and save it to your desktop or 
other specified location that you have reserved for 
saved presets.

You can then share this preset file with others who 
may then import it. 

Sharing Presets
Feel free to share your saved presets by emailing 
them to your friends and having them put it into their 
Topaz DeNoise Presets folder.  

Importing Presets
To import a preset file, click the “Import” button.

This will open up a “Browse” box to import a saved 
preset from your computer into Topaz DeNoise. This 
is useful if you have downloaded a preset file that 
you’d like to use. 

Visit the Topaz Labs Blog which features the latest 
Photography, software and design information including 

tutorials, videos, and thoughts about both Topaz and 
non-Topaz topics.
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Work Area

Tools
You will use the various tools in the tools panel during 
your workflow to make your image adjustments.

1. Preview Navigator - Displays the region of the
preview image you are currently focused on.

2. Zoom Buttons - Use the zoom buttons to zoom in 
and out of your image.

3. Preview Display Modes - View image noise based on 
the color channel that it is in.

4. Auto Brightness - add temporary brightness to your 
image to help you identify and remove noise. 

5. Undo and Redo buttons - reverse and reapply im-
age settings. 

6. Snap & Recall buttons - save up to 99 snap shot set-
tings for comparison. 

7. Sliders and Parameters - Controls the editing pro-
cess using sliders to adjust the various effects.

8.  Reset All Button - Use the “Reset All” button to 
reset all of the sliders values back to zero. 

1

3

5

4

2

6

7

8
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Check for Update
Checks for available Topaz DeNoise updates. 

Click the Show Details button to get find out what’s 
included in the update before you install. 

Menu
You can access Topaz DeNoise’s menu by clicking on 
the “Menu…” button at the bottom of the interface. 

Preferences
Select this to make changes to the DeNoise auto 
update feature, enable or disable the tool tips, or to 
select your startup parameter settings. 

Work Area

The Parameter settings at startup option allows you to 
set the startup parameter settings to Absolute or Relative.
Relative is the default setting.  Please see page 54 for more 
information about  the Absolute and Relative settings. 
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Work Area
Gallery
Select this to open up your Internet browser and go 
to the Topaz DeNoise image gallery to see other user 
images enhanced with Topaz DeNoise.

MyTopaz
Brings you to the Topaz community where you can 
connect and interact with other Topaz users.  Here 
you can also participate in discussions and contests, 
and share your favorite Topaz images. 

Tutorials
Brings you to the Topaz DeNoise tutorials page where 
you can access a variety of helpful video and text tu-
torials.  You can also submit tutorials that you created 
here as well.

About
Select this to see what version of DeNoise you cur-
rently have.

Enter Key
Select this to enter your trial or purchased license key. 

What’s This?
Select this (or click F1) then click on a feature in the 
DeNoise interface to learn more about it. 

Users Guide
Select it to pull up this user guide.

Tech Support
Brings you to the Topaz Labs support page where 
you can request assistance from our support special-
ists, contact our customer service team, retrieve lost 
license keys, or browse through our Knowledge Base. 

Product Info
Select this to go to the Topaz DeNoise web page to 
learn more about the Topaz DeNoise plug-in.
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Settings & Parameters 

Parameters
 Topaz DeNoise has three settings tabs and a total of 10 
parameters, plus 5 display modes, to help you achieve 
optimal image results. 

Noise Reduction
The Noise Reduction tab includes parameters that are 
related to noise removal.  These tools are the main 
ones that you will use, and they will resolve most of 
your image noise issues.  This is also where you will 
start when making any adjustments in DeNoise.  All 
of the subsequent sliders are relative to the Overall 
Strength slider.

Overall Strength
This is the main noise removal tool that reduces overall 
image noise that affects the entire RGB image.  Over-
use can soften the image so use with care.  

For most users, “Overall Strength” is the only feature 
you will need to use when editing images that have noise 
issues. Be sure not to use too strong of a value with the 
“Overall Strength” slider or this may cause your image to 
lose detail and edge sharpness. 

Before Topaz DeNoise After Topaz DeNoise
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Detail Recovery
The Detail Recovery tab offers additional tools that can 
help create a well-balanced image.  This is where you 
will do your fine-tuning by restoring image details. 

Recover Detail
Brings original details back into the image.  A good way 
to use this parameter is to first set it to “0”.  Then after 
you have made your noise reduction adjustments, you 
can gradually increase this parameter to bring back 
more detail.  Overuse can reintroduce noise into your 
image,  so use with care.

Adjust Shadow
This parameter is relative to the Overall Strength slider 
and adjusts the noise removal strength in shadow 
(darker) areas of the image.

Adjust Highlight
This parameter is relative to the Overall Strength slider 
and adjusts the noise removal strength in the highlight 
(lighter) areas of the image.

Adjust Color - Red
This parameter works in conjunction with the “Red” 
Preview Display Mode, to reduce corresponding noise 
in that channel. 

Adjust Color - Blue
This parameter works in conjunction with the “Blue” 
Preview Display Mode, to reduce corresponding noise 
in that channel.

Clean Color
Controls the relative amount of color. Raising this 
value helps to correct images that contain random 
bits of color.

Correct Black Levels
Restores the true richness of blacks and shadows. 
Raising this value increases the saturation of black 
levels in your image. 

Settings & Parameters 
DeNoise offers 6 different 
Preview Display Modes 
that you can use to help 
with noise removal and 
detail recovery while 
using Topaz DeNoise.

Enable the “Auto-Brightness” feature to brighten the 
image for better viewing of artifacts in dark areas.  Au-
to-Brightness is for previewing only, your image will not 
stay brightened once you process your adjustments. 

 

The Adjust Shadow slider coincides with the Correct Black 
Levels slider.  As you increase the value of the Adjust 

Shadow slider you are removing more noise from shadow 
areas and exposing more black / shadow areas. 

This offers the Correct Black Levels slider more black / 
shadow area to evaluate and restore richness to.
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The debanding tab allows you to remove horizontal 
and / or vertical banding from your image.

Horizontal (Checkbox) 
Selecting this option targets the horizontal banding in 
your image. 

Vertical (Checkbox) 
Selecting this option targets the vertical banding in 
your image. 

Banding Width
Determines how much debanding strength is applied 
to the selected direction. 

Reduce Blur
This parameter is an intelligent de-blurring function 
that is useful for correcting blurry or soft edges after 
removing noise.  This parameter should not be set 
higher than necessary because that may result in edge 
halos and noise amplification.

Add Grain
Adds fine monochromatic grain to the image for a 
lightly textured and natural look.

Settings & Parameters 

 

There are two types of banding noise that appears in 
images: short banding and long banding. 

Short banding appears in isolated areas of the image. 
Long banding extends across the entire image from end 
to end.  The Debanding tool in Topaz DeNoise 5 targets 

only instances of long banding. 

 

For more information about noise reduction, debanding 
and example images please visit the Topaz Blog

online at: www.topazlabs.com/blog

http://www.topazlabs.com/blog
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In this section we will show you how to prepare your 
RAW image for use in DeNoise 5.  In order to get the 
best results with DeNoise we will need to disable the 
noise controls in Camera Raw. 

1. Start by opening your RAW image in Photoshop. 
Your Camera Raw interface will automatically load.

2. Go to the Detail tab and disable the Noise Reduc-
tion feature by setting the sliders to 0. 

Please make sure that you do NOT change the size of 
your image.  Images are best left at 16-bit. 

3. After that, click Open Image to begin working with 
DeNoise. 

Tip: If you plan to use DeNoise often then it a good 
idea to save your “Open Raw” settings as a preset so 
that you do not have to manually disable the sliders 
each time. 

Workflow
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Camera Raw allows you to save your image settings 
so that they can be reapplied to any image at any 
time.  It is recommended that you do this because it 
will allow you to quickly disable the “Sharpening” and 
“Detail” settings in Camera RAW, so that you can beg-
ing editing your image with DeNoise. 

You can Save new Camera Raw defaults. This will au-
tomatically apply the defined settings to every image 
opened in Camera Raw. 

To do this, click on the Menu button and select Save 
Setting, then make your Subset selections and click 
Save.  Now each time you open an image in Camera 
Raw these default settings will be applied. 

Workflow
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Workflow
We will be using this noise-damaged image for our 
example.  The goal for this image is to remove noise 
while retaining and restoring obscured image de-
tails.  In the following steps, we will show you how to 
achieve optimal results with your own photos, follow-
ing this model.  So, let’s get started.

1. After you make your Camera Raw selections, open 
your image file in Photoshop.

2. Go to Filter -> Topaz Labs and select DeNoise 5. 

 

Sample Project #1
In this section, we will walk you through a sample 
project, step-by-step, to help you become more famil-
iar with the DeNoise program and how you incorpo-
rate it into your post processing workflow. 

Before Topaz DeNoise

After Topaz DeNoise
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Workflow
So again, what we want to do is improve the qual-
ity of this image by removing the color noise that is 
obscuring the window, building and tree detail.  To 
achieve this we will be working with the Presets and 
then adding in some additional manual adjustments, 
but you can start any way you like.

3. Once your image loads, click the Reset All button, 
then use your zoom tools and preview navigator to 
focus in on a mid-tone area with a strong presence of 
noise.  This will help you to easily identify noise, and it 
will make your subsequent adjustments easier to see. 
Please note: Mid-tone and shadow areas show noise the 
best. 
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Workflow
For this image we will be using the “Raw with moder-
ate noise” preset. 

Tip: Use the preview navigator to pan and Preview Dis-
play Mode options to look at every aspect of your image 
to be sure that you are happy with the settings before 
moving on to manual adjustments or processing. 

4. If you want to choose a default preset, scroll 
through the panel on the left side of the screen.  Be 
sure to try out each of the presets until you find the 
one that works best for your image.

5. Click on the preset name to select it and  the pre-
defined settings will be applied to your image.
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then you can click “OK” to process your image and 
save it back to Photoshop. 

And that’s it.  Your image is now clean, clear and noise 
free. 

Tip: Save your settings as a preset before process-
ing. This will allow you to recall the settings and apply 
them to any image taken at that same ISO on your 
camera - saving you lots of time later on!

Workflow

Please visit the Topaz DeNoise website at http://www.to-
pazlabs.com/DeNoise for video tutorials, tips, and tricks!

***Split screen preview is NOT available in DeNoise 5 and is only used here for comparison purposes.***
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Workflow

Before Topaz DeNoise
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Workflow

After Topaz DeNoise
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color that are obscuring detail and distorting color in 
the young lady’s boots.  Our goal here is to remove 
these defects and smooth out the color in the boots. 

We will be manually adjusting the sliders to remove 
the image noise, but you are welcome to start any 
way you like.  Let’s get started.

1. To begin working on your image go to Filters -> To-
paz Labs and select DeNoise 5. 

Sample Project #2
In this project, we will walk you through a second 
DeNoise workflow.  In this example we will focus on 
the optimal way to remove noise from a jpeg image. 

We will be using this photo of a pair of boots for our 
example. Jpeg images are compressed and typically 
have less ‘fine” noise.  This means that we will be able 
to apply a higher Overall Strength slider value. 

                                

Workflow

Before Topaz DeNoise Before Topaz DeNoise
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to focus in on a specific part of your image.  You will 
want to focus in on a mid-tone area as it will best dis-
play the noise present in your image. 

Tip: Set the Auto-Brightness feature to normal or 
strong in order to better see the noise in your image.

2. Once your DeNoise interface opens, click the Reset 
All button located in the bottom right hand corner 
of the interface.  This will set all of the sliders to their 
default values. You will always want to start with the 
default values when making manual adjustments.  

 

Workflow

Need to reset only one slider value? 
Double-click on the slider name above the slider control 

to instantly reset the slider value to it’s default value. 
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Tip: As you are making adjustments with the Overall 
Strength slider, be sure to monitor your adjustments in 
both the RGB and Luma Preview Display Modes which 
directly correspond with that slider. 

4. Starting with the Noise Tab, adjust the Overall 
Strength slider.  This will eliminate most of the noise 
in your image.  Be sure not to over use this slider.  Do-
ing so will over-smooth your image. 

Workflow

Don’t forget that you can use the shortcut keys in 
Topaz DeNoise to speed up your workflow.
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Workflow
You will also want to adjust your Adjust Shadow and 
Adjust Highlight sliders while in the Luma preview 
display mode.

5. Focus in on a dark area of your image to begin mak-
ing adjustments with the Shadow Area slider. 

6. Focus in on a light area of your image to begin mak-
ing adjustments with the Highlight Area slider.  

If your image has vivid shadowed or highlight areas 
with noise, then you will also want to use the Adjust 
Use of these sliders is not always necessary and will 
depend on your image needs. 

The best way to get great-looking images is to experiment with 
the filter until you’re satisfied. Despite the number of sliders and 
settings, getting a great result is easier than you might think!
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8. Switch to the Blue preview mode to adjust the noise 
level in the Blue Channel.  You will use the Adjust Color 
-  Blue slider to do this.  Before you adjust the slider, 
use your spacebar shortcut key to preview the origi-
nal image so that you can see how the blue noise is 
displayed.  Then proceed to increase or decrease the 
slider.

7. Switch to the Red preview mode to adjust the noise 
level in the Red Channel.  You will use the Adjust Color 
- Red slider to do this.  Before you adjust the slider, 
use your spacebar shortcut key to preview the origi-
nal image so that you can see how the red noise is 
displayed. Then proceed to increase or decrease the 
slider. 

***Split screen preview is NOT available in DeNoise 5 and is only used here for comparison purposes.***
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dom or faint blocks of color in your image.  You can 
slightly increase the Clean Color slider to remove the 
color blocks and balance the color in your image. 

10. The presence of noise often leaves a red or blue 
color cast over your image.  Increase the Correct Black 
Level slider to restore the color richness in the  black 
and shadow areas.

Now we are ready to move onto the Detail Recov-
ery Tab.  The adjustments made here will allow us to 
recover image detail, reduce image blur and enhance 
edges and lines. 

11. Slowly adjust the Recover Detail slider.  This slider 

reintroduces original details back into the image that 
were suppressed during noise removal.  Over applying 
this parameter will reintroduce noise and sometimes 
color unevenness back into your image, so use with 
care. 

12. Next, we will work on the sharpness of the image 
using the Reduce Blur slider.  Pan to an area in your 
image that has sharp edges and then slowly adjust 
this slider to improve edge visibility.  For this image, 
we will focus in on the edges of the young lady’s 
boots.  As you adjust this slider you will notice the 
lines and edges becoming clearer and more distinct. 

13. You can also increase the add Grain slider to add 
texture to your image to keep it looking natural. 
The other benefit of using grain is that it is small and 
monochrome.  Meaning that there will not be any 
color side effects.  However, we will not be adding 
any for this image. 

14. Compare the Original and Preview of your adjusted 
image using the tabs, your spacebar shortcut key or 
by clicking on the preview image.  Once you are happy 
with your settings you can click OK to process your 
image and save it back to Photoshop. 

Workflow

14. Compare the Original and Preview of your adjusted14. Compare the Original and Preview of your adjusted
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Workflow

After Topaz DeNoiseBefore Topaz DeNoise

And that’s it! You should now have a clean, noise free image that is ready for 
any additional color, detail or creative adjustments that you have in mind. 
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Workflow

Sample Project #3
In this project, we will walk you through a third
DeNoise workflow that includes debanding and black 
level color correction.  We will be using this night shot 
as our example.  As you can see, in addition to noise, 
this image also has a red color cast and slight  banding 
noise.  Our goal here is to remove these defects and 
restore the image color. 

We will be manually adjusting the sliders to remove 
the image noise, but you are welcome to start any 
way you like. Let’s get started.

1. To begin working on your image go to Filters -> To-
paz Labs and select DeNoise 5. 

2. Once your DeNoise interface opens you can use the 
zoom and preview navigator (or hand tool) to focus 
in on a specific part of your image.  You will want to 
focus in on a mid-tone area as it will best display the 
noise present in your image. 

3. Click the Reset All button located in the bottom 
right hand corner of the interface.  This will set all of 
the sliders to their default values.  You will always 
want to start with the default values when making 
manual adjustments. 

After Topaz DeNoiseBefore Topaz DeNoise
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show just the luminant information. 

5. Use the zoom and preview navigator (or hand tool) 
to focus in on a specific part of your image.  You will 
want to focus in on a mid-tone area as it will best dis-
play the noise present in your image. 

6. Go to the Noise Reduction tab and adjust the 
Overall Strength slider.  This will eliminate most of the 
noise in your image. 

Tip: The Overall Strength slider value is key to getting 
optimal image results.  If you use too strong a value the 
image will become very smooth and too soft.  Too small  
a value will leave a lot of noise residuals. 

Workflow
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slider value here.  If you see too much smoothing or 
a loss of detail in the highlight areas then reduce the 
Adjust Highlight slider value.

Details are all in the luma channel, so we will make 
detail adjustments next. 

7. Pan to a dark / shadow area in your image.  You 
can turn on the auto brightness feature which will 
allow you to better identify the noise in your image.  
Increase Adjust shadow slider and it will reduce the 
noise in shadow areas. 

8. Pan to a highlight area of your image and look for 
noise.  Generally, highlight areas do not usually need a 
lot of noise reduction.

Workflow
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Workflow
9. Go to the Detail Recovery Tab and slowly increase 
the Recover Detail slider.  This will reintroduce original 
details back into the image that were suppressed dur-
ing noise removal. 

10. Next, we will work on the sharpness of the image 
using the Reduce Blur slider.  Focus on an area in your 
image that has sharp edges and then slowly adjust 
this slider to improve edge visibility.  

11. You can also increase the add Grain slider to add 
texture to your image to keep it looking natural. 

12. Go to Red Preview Mode to see red color informa-
tion.  Increase the Adjust Color - Red slider to suppress 
more of the red noise.

13. Go to Red Preview Mode to see red color informa-
tion.  Increase the Adjust Color - Blue slider to suppress 
more of the blue noise.
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Workflow
15. Remove horizontal and vertical banding noise using 
the debanding tab.  Select the direction of the pres-
ent banding noise and then slowly adjust the Banding 
Width slider to remove it. 

16. If you notice a leftover hazy color cast the go to the 
Noise Reduction tab and Increase the Correct Black 
Levels slider to clean up the haze and restore the black 
levels in your image.

Tip: You can also use the Adjust Color - Red and Adjust 
Color - Blue sliders to help balance color in your image. 

14. If you notice blocks of color noise in your image, 
you can use the Clean Color slider to remove them and 
smooth out the color in your image.   Change back to 
the RGB color mode to help you see the effects of this. 
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Workflow

After Topaz DeNoiseBefore Topaz DeNoise
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Workflow
Step 2. Create the Preset Profiles
We are going to edit each image in DeNoise starting 
with the 12800 ISO shot (or whichever is the highest 
that you shot). 

1. Open your RAW image in Photoshop and invoke 
DeNoise (don’t forget to disable the Camera Raw set-
tings. See page 30 for more instructions). 

2. In DeNoise, go to Menu -> Preferences and change 
the Parameter Setting at Startup to Absolute. 

The Absolute and Relative parameter settings deter-
mine how the parameter settings from your previous 
DeNoise session are viewed.  Under the Absolute 
setting, when you open DeNoise the slider values and 
noise removal will be set at the same exact values 
that were applied to the last image you processed 
with DeNoise.  This is ideal if you plan to do batch pro-
cessing and you have multiple images with the same 
ISO and characteristics. 

Under the Relative setting, when you open DeNoise 
the slider values will shift and give you an estimate of 
the image and noise settings based on your last ses-
sion. 

Camera-Specific Presets
In this section we are going to show you how to cre-
ate your camera-specific presets.  DeNoise 5’s ad-
vanced technology allows you to create preset pro-
files for your camera type and various ISO settings. 

This capability is extremely valuable because it will 
allow you to easily process your images  shot with 
specific ISO settings. 

Creating camera-specific presets is a two-step process 
which includes taking shots at different ISO’s and then 
using each shot to create your default preset for that 
ISO setting. 

Step 1. Take the shots

You will need to take your shots. We recommend the 
following ISO’s:  200, 400, 800, 1600, 3200, 6400 and 
12800.

If desired you can include 100 and 25600 or omit any 
of the previous ISO’s that you do not typically use dur-
ing shooting. 
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Workflow

IMPORTANT!: Make sure that when saving your pre-
set that you save the Preset Type as Absolute. 

7. Click OK to save your preset.  Your new 12800 ISO 
preset should be listed in your Presets Panel. 

Now that we have created our first preset we can 
move on and create the others.  Because we started 
with the highest ISO setting, this is actually going to 
make creating the lower ISO’s a breeze. 

1. Open your 6400 ISO image and invoke Topaz De-
Noise. 

2. Pan to a mid-tone area of the image and then apply 
your 12800 ISO preset. 

3. We will start with the 12800 ISO shot (or whichever 
is your highest ISO shot) and begin the noise removal 
process.  Pan your image and find a mid-tone area to 
work on. 

4. You can select one of the default presets or you can 
start manually, using the Overall Strength slider found 
in the Noise Reduction Tab.  Slowly work your way 
down through each slider gently making adjustments 
until you are happy with the results. 

5. Once you are happy with your selections click on 
the Save button at the bottom of the Presets panel to 
save your new 12800 ISO preset. 

6. Enter all of your Camera and image information, 
and set the Preset Type to Absolute. 

As you are making your slider adjustment keep 
the following workflow tips in mind:

1. Find a mid-tone area to focus in on. This will 
help you to easily identify and remove noise.

2. Use the Auto-brightness feature to make 
noise more visible.

3. Switch between the various Preview Display 
Modes and pan your image as you are making 
adjustments.

4. Toggle between your Original and Preview 
image to see the changes. Use the spacebar 
shotcut for this.
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Workflow
3. Slightly adjust the Overall Strength slider to a lower 
setting.  This should be minimal and is generally the 
only change that you will need to make. 

4. Switch Preview Display Modes and toggle between 
your original preview and adjust preview to achieve 
optimal results. 

5. Once you are happy with your settings click on the 
Save button at bottom of the Presets Panel to save 
your new 6400 ISO preset. 

You will continue on in this pattern working your way 
down to your lowest ISO setting.  Each ISO preset 
made will be the starting point for the next preset 
you will make, and you should only need to adjust the 
Overall Strength slider as you go along.

 So, as you load each lower ISO image into DeNoise, 
make sure that you are selecting the most recent 
preset made for the ISO above to use as your starting 
point. 

Once you finish your last ISO profile, you will have a 
complete noise reduction set based on your camera 
and ISO settings. 

These new presets will definitely come in handy dur-
ing your post processing and will help you to further 
increase the speed and ease of your noise reduction 
workflow. 
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Glossary
made up of a specific primary color.  In a typical digital 
photo, the primary colors of red, green and blue 
(from the RGB color model) create all the colors in 
that photo, which may be represented by three color 
channels, each of red, green or blue.

Color Noise – A type of digital noise in which color 
edges are blurred or the image is unevenly colored 
and filled with spots.

Color Profile - defines the range of colors that can ap-
pear in a digital photo.

Debanding - Removing banding noise from images 
and restoring image color and detail. 

DeBlur - A method for reducing image blur while 
sharpening image details. 

Download - The process of transmitting or transfer-
ring data from one device to another.

Export - Outbound data transfer in a format that can 
be used by other programs.

Grain –Lightly speckled noise that is used to apply a 
more natural look to an image. 

Image - An array of pixels that make up a digital pic-
ture. 

Import - Inbound data transfer into a file or docu-
ment.

ISO - The amount of sensitivity of a digital camera sen- 
sor. A higher ISO enables faster shutter speeds and/or 
better performance in low light, but is more suscep-
tible to experiencing increased noise.

Achromatic - Without color.

Action - A set of edits or adjustments that are record-
ed and remembered by Photoshop and can be played 
back later on any image. 

Algorithm - Any bit of code or programming that de- 
fines a process.

Auto-brightening – Temporary visual setting that 
brightens the preview image, allowing noise to become 
more visible during removal.  Brightness will not be per-
manently applied to image.

Banding Noise - Banding noise is a camera-induced 
artifact that appears in digital images as parallel pat-
terns of horizontal and vertical lines. These lines often 
appear colorful. 

Batch Processing - The automated process of editing 
multiple images with the same adjustments and cor-
rections. 

Blur - Make or become unclear or less distinct.

Brightness - The degree to which a color sample ap-
pears to reflect light. 

Chroma - Purity or intensity of color.  The difference 
of a color against the brightness of another color that 
appears white under similar viewing conditions.

Color - The human perceptual response to different 
wavelengths of light impinging on the photo recep-
tors in the retina.

Color channel - The visual component of a color digi-
tal image that represents all the pixels in that picture 
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Plug-in - A computing feature with the ability to be 
added to a system to give extra features or functions.

Preset - A pre-defined combination of parameters and 
settings that is saved into a folder within Topaz De-
Noise. Topaz provides default presets.  A preview of 
each preset can be seen in the preset preview win-
dow located at the top left hand side of the interface 
above the preset list. 

Preview- Shows the processed preview of the image.

RAW image - An image file format that contains un- 
touched, “raw” pixel information straight from the 
digital camera’s sensor.  It has yet to translate the in-
formation in each pixel into the full color information, 
so this format offers more control over how the final 
JPEG or TIFF image is generated. 

Reduce Blur - An de-blur function that uses decon-
volution technology rather than simple sharpening 
techniques.

Refine – Improve (something) by making small chang-
es to make it more subtle and accurate. 

RGB - Red, Green, Blue.  The color model that is used 
in digital cameras and by computer monitors.

Sharpness - The clarity of detail in a photo.

Smoothing - To make a surface more regular or con-
sistent; free from perceptible projections, lumps, or 
indentations.

Shadow - A dark area or shape produced by a body 
coming between rays of light and a surface.

Luma (Luminance) - The brightness in an image (the 
“black” and “white” or achromatic portion of the im-
age).  Luma represents the achromatic image without 
any color, while chroma components represent the 
color information.

Noise - Visible effects of interference in an image from 
a digital camera.  Often appearing as random col-
ored dots sprinkled throughout the image or uneven 
coloration in what should be smoothly-colored areas. 
It is most likely to show up in the darker or shadowed 
areas of an image.  Noise can be an undesirable effect 
that detracts from overall image quality or something 
you can choose to create artistically.

Pan and Zoom - A useful function that allows users to 
magnify the captured image in the preview and then, 
by using the cursor, to move or pan around the image. 
Typically Pan and Zoom allows users to magnify the 
image 2x or 4x time.  By magnifying the images and 
zeroing in on a specific section, you can see details 
not visible when the entire image is sized to fit the 
preview.

Parameter - A numerical or other measurable factor 
forming one of a set that defines a system or sets the 
conditions of its operation.

Photo-editing or Imaging software – Programs in 
which you can alter your photos and / or create digital 
images.  Depending on the software, you can improve 
exposure, color and other attributes of your picture, 
paint on it, add type, apply special effects, remove 
noise, resize it, combine it with other pictures, prepare 
it for e-mail or posting on the web, output it to a print-
er, or do any number of other manipulations or edits.
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into the Photoshop Plug-Ins folder. 
3. Quit and restart Photoshop and Topaz DeNoise 5 will 
appear in your Filters menu. 

“Do you have any other DeNoise tutorials?”
Yes, please see pages 34, 40 and 47 of this Topaz De-
Noise user guide.  You can also visit: http://www.topa-
zlabs.com/tutorials/DeNoise for additional tutorials and 
DeNoise resources. 

“I do not have Photoshop, will  DeNoise work with 
my Elements, Aperture, Lightroom, iPhoto Paint Shop 
Pro, Photo Impact or Irfanview?”
Yes, you can use Topaz DeNoise with any of the above 
host programs. However, to use DeNoise in Aperture, 
Lightroom or iPhoto, you will need to download the 
free Topaz Fusion Express add-on.  For more informa-
tion please visit: www.topazlabs.com/fusion

“What are the limitations of the trial version of your 
software?”
The only limit on the trial versions of the Topaz plug-ins 
is time.  The free trial versions are designed to enable 
you to experience the full functionality of our plug-ins 
for a 30-day trial period.  After the trial period is up, you 
will only be able to use the Topaz software by purchas-
ing it.  You will then receive a license key to activate the 
plug-in, and the trial version will automatically become 
the full version with no time limitations.          

“I need a Topaz DeNoise trial key.” 
Visit http://www.topazlabs.com/downloads for a trial 
key. Please check your Spam folder because your Spam 
filter sometimes filters out the automated email. 

If you need more time to evaluate, please contact us at: 
www.topazlabs.com/support
 

 “I can’t find Topaz DeNoise in the Photoshop Filters 
menu.” 
If you’re using Windows: 
1. Go to C: \ Program Files \ Topaz Labs \ Topaz DeNoise 
4 \ Plugins. Right click the file “tlDeNoise5.8bf” and 
click “Copy”. 
2. Go to your Photoshop Plug-Ins folder, usually located 
at C: \ Program Files \ Adobe \ Adobe Photoshop CSx \
Plug-Ins. First, delete anything that is currently there 
that has to do with Topaz DeNoise 5 This includes any 
folder that might be labeled “Topaz DeNoise 5” or any 
tlDeNoise5.8bf file. After doing that, right-click on any 
empty space and click “Paste”. 
3. Quit and restart Photoshop and Topaz DeNoise will 
appear in your Filters menu. 

If you’re using Mac: 
1. Go to Macintosh HD / Library / Application Support / 
Topaz Labs /DeNoise5 / Plug-ins and right-click Topaz_
DeNoise5.plugin. Click “Copy”. 
2. Go to Applications / Adobe Photoshop CSx / Plug-Ins 
(or wherever your Photoshop Plug-Ins folder is locat-
ed). Delete any current reference to Topaz DeNoise 5. 
Afterwards, right-click any 

Frequently Asked Questions
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Frequently Asked Questions
“If I use the 30-day trial version will I need to uninstall 
the trial version before I upgrade to a full version?”
No, the Topaz trial software is designed to be unlocked 
to become the full version simply by entering a license 
key.  The full license key will be e-mailed to you immedi-
ately after you purchase the software.

“Where do I enter my key?”
To enter your key please open an image in Photoshop 
and go to Filter -> Topaz Labs -> DeNoise 5 -> Menu -> 
Enter Key. You can then copy & paste or type in your 
license key and then select OK.

“I had Topaz DeNoise as a trial, then I purchased. How 
do I enter my new license key?”
You can enter your new license key by opening up an 
image in Photoshop and go to Filter -> Topaz Labs -> 
DeNoise 5 -> Menu -> Enter Key.  Please remove the 
trial key and enter your new purchased license key, 
then select OK and you are all set. 

“My Topaz DeNoise key doesn’t work!”
There are a couple of reasons why Topaz DeNoise 
might think your license key is invalid.

First, make sure that your key is in the proper format. 
It’ll be in the format “xxxxxx-xxxxxx-xxxxxx-xxxxxx-
xxxxxx” and will be all numbers in 30 digits in five 
groups of six (no letters). 

Second, make sure that as you’re entering the key 

there is nothing in the space beforehand.  This means 
clicking, pressing Ctrl-A, and hitting delete to make sure 
that absolutely nothing is in that field before you paste 
in the key.

If it doesn’t work when you copy and paste, try typing 
it out, and vice versa.

My Topaz filters are grayed out in the filter menu. 
Please make sure that you are using a 8-bit or 16-bit 
image that is in RGB color mode.  Also, if your project 
includes adjustment layers please make sure that you 
are not on an adjustment layer.  You will need to select 
the image layer.  This will allow you to access your To-
paz programs. 

I have a question not listed here. 
Please visit our knowledge base online at: 
http://www.topazlabs.com/support/kb/

If you are not able to find the answer there then con-
tact our support specialists online at: www.topazlabs.
com/support or e-mail customer support at: help@
topazlabs.com

http://www.topazlabs.com/support/kb/
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Shortcut Keys
Topaz DeNoise 4 offers the use of shortcut keys to help speed up your workflow. Many of 
these keys are similar to the ones used in Photoshop. The following keys work at all times:  

Spacebar		       Spacebar	      	 View Original Image	
CMD-ALT-R		    CTRL-ALT-R      	 Reset All			              
+ or CMD - +		    + or CTRL - +     	 Zoom In	
- or CMD - - 		  - or CTRL - -          	 Zoom Out			              
CMD -Z 		    Ctrl - Z	      	 Undo				               
CMD - Shift - Z	   Ctrl - Shift - Z    	 Redo				              		

MAC Shortcut 	      PC Shortcut 	      Action

N					          	 Expands / Collapses Noise Reduction Tab
D						      Expands / Collapses Detail Recovery Tab
G						      Expands / Collapses Debanding Tab
A					          	 Switches to RGB Preview Mode	
L					          	 Switches to “L” Preview Mode
C					          	 Switches to “C” Preview Mode
R					          	 Switches to “R” Preview Mode
B					          	 Switches to “B” Preview Mode
X					          	 Turns the Auto-bright feature off
Y					          	 Sets the Auto-bright feature to Normal
Z 					          	 Sets the Auto-bright feature to Strong
S					          	 Takes a Snapshot
CMD-Shift-P		   CTRL-Shift-P   	 Recalls previous Snapshot
CMD-Shift-N		   CTRL-Shift-N		 Recalls next Snapshot
CMD-1			   CTRL-1		  View Original Image
CMD-2			   CTRL-2		  View Adjusted Image
Left or Right Arrow Key		      	 Scrolls through presets
Return (enter) key			        	 Applies selected preset
[ key 					          	 Reduces selected slider value by 0.1
] key					          	 Increases selected slider value by 0.1
Home Key 				         	 Set the slider value to minimum
End Key			       	      	 Set the slider value to maximum
Double-click slider name		       	 Resets the slider to it’s default value

Mac  and PC Shortcuts are the same unless indicated otherwise. 
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Connect with Topaz

Follow us on Twitter for notifications of 
recent news and easily get in touch with us 

whenever you feel like it!

Find us on our Facebook page and network 
with other Topaz users!

Participate in the entirely user-led Topaz 
Flickr group for a helpful and highly active 
community for Topaz Photoshop plug-ins!

Subscribe to our YouTube channel to keep 
up with any newly released product video 

tutorials!

Check out our new Forum and our blog for 
tutorials, tips and updates from Topaz Labs!

http://www.topazlabs.com/forum
http://www.facebook.com/pages/Topaz-Labs/19955996369
http://www.flickr.com/groups/topaz
http://twitter.com/topazlabs
http://www.youtube.com/topazlabs
http://www.topazlabs.com/forum
http://www.topazlabs.com/blog
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Topaz Labs LLC, a privately owned company in Dallas, Texas, focuses on developing advanced video and image enhance-
ment technology. With today’s widespread use of digital still cameras, digital video cameras, and HDTV, the need for high-
quality digital images and videos has greatly increased. Topaz Labs’ mission is to bring practical state-of-the-art image and 
video enhancement technology to both professionals and consumers.

Contact Information
	

Topaz Labs LLC
5001 Spring Valley Road
Suite 400 East
Dallas, TX 75244

Technical Support
Visit: http://topazlabs.com/support/

Copyright © 2009 Topaz Labs, LLC. All rights reserved. http://www.topazlabs.com
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Image Plug-ins    

Go to http://www.topazlabs.com/downloads to get your 30-day free trial!

Ultimate control over 
image exposure, detail, 
and color gives you the 
power to make your 
photos pop.

Specializes in creat-
ing crisp and stylized 
images. Also features 
extensive smoothing 
capabilities. 

Advanced noise reduc-
tion filters noise while 
maximizing and retain-
ing image detail simply 
and effortlessly.

Takes any of your 
regular photos and ef-
fortlessly turn them into 
beautiful works of art.

Specializes in overall 
image improvement. 
Features sharpening, re-
constructing, enlarging, 
high-quality noise 
removal and JPEG arti-
fact damage tools. 

Increase video quality with this suite 
of video enhancement filters utilizing 
super-resolution technology. 

Advanced JPEG artifact 
reduction filters elimi-
nate JPEG compression 
artifacts while preserv-
ing image detail like 
never before. 

Video Plug-ins 

3 levels of intricate and 
specific detail enhance-
ment for naturally 
enhanced images with 
no halos. 

Bring the power of 
Topaz to your Aperture, 
iPhoto and Lightoom 
workflow with the new 
Fusion Express plug-in.

Remove unwanted 
backgrounds from your 
digital images quickly 
and easily with the new 
Topaz ReMask. 

Easily and efficiently capture video 
frames and significantly increase their 
quality and resolution with this stand-
alone Windows application. 




